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Introduction

This utility is designed to make changes to the Windows registry. It allows you to customise the Desktop, Start 
menu, and it will change several other settings for you. For a complete overview of all functions see the chapter 
Functions.

In the past, the only way to change these settings has been to manually edit the registry, which is a time-
consuming and - especially for novices - not recommended task. 

Windows Tweaking Toolbox is a foolproof method to change these settings easily and quickly. It works for all 
versions of Windows 95 and Windows 98 and for all language versions.

Contents:
· Operating System Support
· Functions
· Menu bar
· Uninstalling
· How to Register
· Credits
 

Licence terms and Disclaimer:

Windows Tweaking Toolbox is shareware. You may evaluate it for a period of 30 days at no charge. If you decide
you to continue using it after this time, you must register it. Registered users will be able to download free or 
discounted updates and are entitled to technical support via e-mail.

The following terms apply to both the shareware (unregistered) and registered versions of Windows Tweaking 
Toolbox:

· Windows Tweaking Toolbox may not be sold or resold in any way, including, but not limited to, selling it as 
part of a permanent sale of the computer system it is installed on.

· Windows Tweaking Toolbox may not be distributed as part of any commercial package.
· Windows Tweaking Toolbox may not be used in a commercial environment, used or distributed in support of a

commercial service, or used or distributed to support any kind of profit-generating activity, even if it is being 
distributed freely.

· All files must remain intact and unmodified from the original as distributed by Graphic Locomotion and 
Windows-Help.NET.



· Including Windows Tweaking Toolbox as part of a shareware distribution, magazine, book, CD-ROM, or 
similar medium requires written permission of the authors.

You are granted the right to distribute the shareware (unregistered) version of Windows Tweaking Toolbox in 
accordance with, but not limited to, the above terms. You are not allowed to distribute the registered version of 
Windows Tweaking Toolbox in any way.

In addition to the above terms, the registered version of Windows Tweaking Toolbox is subject to the following 
terms and conditions:

· You may only install and use one copy of Windows Tweaking Toolbox; installing and using more than one copy
requires you to purchase the corresponding number of copies of Windows Tweaking Toolbox.

· Windows Tweaking Toolbox may not be installed, accessed, displayed, run, shared or used concurrently on or 
from different computers, including a workstation, terminal, or any other digital electronic device.

· You may make a single backup copy of Windows Tweaking Toolbox. This backup copy may only be used for 
archival purposes.

· On computer systems running more than one operating system, you may install at most one copy on each 
operating system, but these copies may not be used simultaneously.

· Windows Tweaking Toolbox is only licenced as a whole; its component parts may not be separated for use on 
more than one computer.

· Renting, leasing, or lending Windows Tweaking Toolbox is not allowed.
· Without prejudice to any other rights, Graphic Locomotion or Windows-Help.NET may terminate this 

agreement if you fail to comply with any of its terms and conditions. In such an event, you must destroy all 
copies and all component parts of Windows Tweaking Toolbox.

Windows Tweaking Toolbox is provided “as-is” without warranty of any kind, either express or implied, 
including but not limited to the implied warranties of merchantability and fitness for a particular purpose. In no 
event shall the authors be liable for any damages whatsoever including direct, indirect, incidental, consequential, 
loss of business profits, or special damages, even if the authors have been advised of the possibility of such 
damages.

Windows Tweaking Toolbox is protected by United States copyright law and international treaty provisions, as 
well as other intellectual property laws and treaties. Modifying, reverse engineering, translating, or disassembling
of this product, in whole or in part, including the program and all its documentation, is strictly prohibited.

Microsoft, MS-DOS, Internet Explorer and Windows 95/98 are trademarks of Microsoft Corporation (which is a 
trademark in and of itself). Other trademarks are property of their respective owners.



Windows Tweaking Toolbox 
Operating System Support

S = Shareware Version (Unregistered)    R = Registered Version
*Note that IE4.x also applies to subsequent versions of IE.

Feature Win 95 Win95 + IE 4.x * Win 98

Registered user S S S
Registered organisation S S S

Windows installation files R R R
Fix optimised File System

settings
R R R

Enable Renaming of Recycle
Bin

S S S

Show all Icons on the
desktop

R R R

Show Network
Neighborhood

S S S

Save settings on exit S S S
Show/Hide Favorites Menu - R R

Show/Hide Documents
Menu

- R R

Show/Hide Find Menu S S S
Show/Hide Run Menu S S S

Show/Hide Log Off <user
name>

- R R

Shut Down S S S
IE title bar S S S

OE title bar - S S
OE data files - R R

OE splash screen - S S
Display Control Panel S S S

Background tab S S S
Screen Saver tab S S S
Appearance tab S S S

Settings tab S S S
Users Control Panel - S S

Password Control Panel R R R
Change Passwords tab R R R

File System button S S S
Virtual Memory button S S S

MS-DOS Prompt R R R
Single-Mode MS-DOS R R R

Windows Update - - S
Task Monitor settings - - R

Windows version S S S



When having a machine configured with user profiles, these settings are user specific:

· The Enable renaming of the Recycle Bin on the Desktop tab
· All settings on the Start menu tab
· The OE data files and OE splash screen on the IE and OE tab
· All settings on the Control Panel tab
· Both settings on the MS-DOS tab

Although you will see the text “Note: This requires a restart of Windows for the changes to take effect” on 
several occasions, when you change a setting which requires a restart of Windows, you will get a warning when 
exiting the program, asking you to restart Windows.

Please note that if you close the program you will lose any changes you made if you did not press the Apply 
button, or did not use Apply all tabs from the Apply/Undo menu.



Functions
General Tab

¨ Registered user
¨ Registered organisation
¨ Windows installation files
¨ Fix optimised File System settings

Desktop Tab
¨ Enable renaming of the Recycle Bin
¨ Show all icons on the desktop
¨ Show Network Neighborhood
¨ Save settings on exit

Start menu Tab
¨ Favorites (IE 4.0+)
¨ Documents (IE 4.0+)
¨ Find 
¨ Run 
¨ Log Off <username> (IE 4.0+)
¨ Shut Down 

IE and OE Tab
¨ IE title bar
¨ OE title bar 
¨ OE data files 
¨ OE splash screen 

Control Panel Tab
Display Properties

¨ Display Control Panel 
¨ Background tab 
¨ Screen Saver tab 
¨ Appearance tab 
¨ Settings tab 

Users Properties
¨ Users Control Panel 

Passwords Properties
¨ Password Control Panel 
¨ Change Passwords tab 

System Properties
¨ File System button 
¨ Virtual Memory button 

MS-DOS Tab



¨ MS-DOS Prompt 
¨ Single-Mode MS-DOS 

Windows 98 Tab
¨ Windows Update 
¨ Task Monitor settings 

Windows version Tab
¨ Windows version 

Please note that if you close the program you will lose any changes you made if you did not press the Apply 
button, or did not use Apply all tabs from the Apply/Undo menu.

When having a machine configured with user profiles, these settings are user specific:

· The Enable renaming of the Recycle Bin on the Desktop tab
· All settings on the Start menu tab
· The OE data files and OE splash screen on the IE and OE tab
· All settings on the Control Panel tab
· Both settings on the MS-DOS tab

Although you will see the text “Note: This requires a restart of Windows for the changes to take effect” on 
several occasions, when you change a setting which requires a restart of Windows, you will get a warning when 
exiting the program, asking you to restart Windows.



Registered user

Changes the value of the registry key that displays the username in most Help - About boxes (and on the 
General tab of System Properties) in Windows as:



Registered organisation

Changes the value of the registry key that displays the organisation in most Help - About boxes (and on the 
General tab of System Properties) in Windows as:



Windows installation files

(registered version only)

Changes the value of the registry key that points Windows to its installation files.

If you added a hard drive after having installed Windows (from CD-ROM), chances are that the drive letter of 
your CD-ROM drive has changed. If Windows needs to install new files from the CD-ROM, you will have to 
(manually) point it to the right drive. 
Now you can set the new value in your registry, and Windows will not bother you again!

You can also use this feature to point to a drive/path location on a hard drive. Just copy all the Windows 
installation files to a hard drive (e.g. D:\WININSTALL\) and change the Source Path to point to this directory.

To change the Source Path, just press the Windows installation files button, you will be presented with a 
Browse for Folder window, what you can use to select the folder where you copied your installation files.

This has the benefit that installing from a hard drive works faster than from a CD-ROM drive. In addition, 
whenever you add or remove Windows components (using the Windows Setup tab of Add/Remove programs), 
Windows will automatically access the installation files from the hard drive without prompting you for the 
correct drive and without prompting you to insert the Windows CD-ROM.

Tip: It is best to copy the installation files to a different hard drive than the drive that holds your operating
system. If, in any event, you have to reformat the drive that holds the OS, you will still have your 
installation files safely on a second drive. In addition, this will save you the trouble of installing drivers to 



access the CD-ROM drive, since Windows does not need the CD-ROM drive during installation from hard 
drive.

Note: this item will be greyed out in the shareware version.



Fix optimised File System settings

(registered version only)

Fix for Incorrect Settings for File System Performance Profiles, applies to:
· Microsoft Windows 95 
· Microsoft Windows 95 OEM Service Release version 1 

Symptoms: 
The performance of the file system on your computer is unchanged or degraded after you select Network Server 
or Mobile Or Docking System in the Typical Role Of This Machine box in the File System Properties dialog 
box. 

Cause:
The NameCache and PathCache values are written to the registry incorrectly for the Network Server and 
Mobile Or Docking System profiles. The data for NameCache is written to the PathCache value, and the data for
PathCache is written to the NameCache value. 

From how the check box and the text are displayed, you can tell the state of the settings:

1. If the check box is checked and greyed out: the system has the correct value
2. If the check box is not checked, and the text is displayed normally, the system values are not correct

Once the values have been corrected, the check boxes will be greyed out permanently. Since Fix optimised File 



System settings is a bug fix (and not an individual customised setting), the fixed settings cannot be undone.

Note: This requires a restart of Windows for the changes to take effect.

Note: this item will be greyed out in the shareware version.



Enable renaming of the Recycle Bin

When checked, it will put a Rename entry on the right-click shortcut menu of the Recycle Bin. 

Note: When using Undo from the menu (registered version only), it will not rename the Recycle Bin back to its 
previous state, it will just remove the Rename entry on the right-click shortcut menu of the Recycle Bin.



Show all icons on the desktop

(registered version only)

When unchecked, hides all the icons on the Desktop. 

When checked, the icons will be restored to the Desktop.

When you are using the Active Desktop (Win95 + IE4 (and higher) / Win98), this will also disable/enable the 
Active Desktop. 

Note: This item takes precedence over the other items, e.g. if you select to show the Network Neigborhood    on 
the desktop, but uncheck Show all icons on the desktop, no icon will be displayed.

Note: This requires a restart of Windows. 

Note: this item will be greyed out in the shareware version.



Show Network Neighborhood

When unchecked it will remove the Network Neighborhood icon from the Desktop and prevent access to 
Network Neighborhood.

When checked, access will be restored (and the icon will re-appear on the Desktop) as soon as you have restarted 
Windows.

Consequences of hiding Network Neighborhood:

Since shell support for the Universal Naming Convention (UNC) notation is handled by the Network 
Neighborhood, hiding the Network Neighborhood icon will prevent Explorer from accessing resources via 
UNCs.    In order to access network resources from Explorer, you need to map them to a drive letter.    Note that 
the MS-DOS command prompt and other applications are not affected by this setting, because they do not use the
Network Neighborhood to resolve UNCs.

In particular, hiding the Network Neighborhood prevents Direct Cable Connection from displaying the contents 
of the host computer. Apart from this, Direct Cable Connection functions normally.

Note: This requires a restart of Windows.



Save settings on exit

Removing the check mark from this item will prevent settings from being written to the file system.
For example, the position of the Taskbar will not be saved, changes to the view setting in Windows Explorer will 
not be saved.

Note: This requires a restart of Windows.



Favorites (IE 4.0+)

(registered version only)

Removing the check mark from this item will remove the Favorites folder from the Start menu. 

This only works with Internet Explorer 4.x or higher installed on the system.

When IE 5.x is installed on the system, it will also remove the Favorites from the IE5.x menu bar (the 
favorites button will still be on the toolbar).

Note: This requires a restart of Windows.

Note: this item will be greyed out in the shareware version.



Documents (IE 4.0+)

(registered version only)

Removing the check mark from this item will remove the Documents folder from the Start menu. 

This only works with Internet Explorer 4.x or higher installed on the system.

Note: This requires a restart of Windows.

In Windows 98, if you want to remove the My Documents folder from the Desktop, right-click the My Documents 
folder, and from the context menu select Remove from Desktop. If you want to put this folder back on the Desktop,
just right-click an empty space on the Desktop, and from the context menu select New > My Documents Folder on 
Desktop.

Note: this item will be greyed out in the shareware version.



Find

Removing the check mark from this item will remove the Find folder from the Start menu. 

Removing the Find folder from the Start menu will also effect the Find function in Windows Explorer. Pressing F3
normally brings up the Find window in Windows Explorer, but if you remove the Find folder from the Start menu, 
pressing F3 in Windows Explorer will be disabled. 

Note: This requires a restart of Windows.



Run

Removing the check mark from this item will remove the Run command from the Start menu. 

Note: This requires a restart of Windows.



Log Off <username> (IE 4.0+)

(registered version only)

Removing the check mark from this item will remove the Log Off <username> command from the Start menu. 

This only works with Internet Explorer 4.x or higher installed on the system.

Note: This requires a restart of Windows.



Shut Down

Removing the check mark from this item will remove the Shut Down command from the Start menu, and disable the
Windows shutdown.

Note: When you have disabled the Windows Shut Down, there is no way to shut down Windows, other then to
do a double [Ctrl] + [Alt] + [Del], a reset, or to switch off the computer’s power. These methods are not 
recommended ways of shutting down Windows.

Shut Down will be re-enabled by putting the checkmark back in the Shut Down item.

Note: This requires a restart of Windows.



IE title bar

Type the text you want to use as your custom title in the Internet Explorer title bar.

Note: This requires a restart of Internet Explorer.



OE title bar

Type the text you want to use as your custom title in the Outlook Express title bar.

Note: This requires a restart of Outlook Express.

Note: When Outlook Express is not installed on your system, this item will be greyed out.



OE data files

(registered version only)

To change the location where Outlook Express stores your files, just press the OE data files button, you will be 
presented with a Browse for Folder window, what you can use to select the folder where you copied your Outlook 
Express files.

You have to copy the Outlook Express files to the new location before opening Outlook Express. If you open 
Outlook Express without copying your data files to the new location, Outlook Express will create new (default) 
folders, like when you start Outlook Express for the first time.

To change the location of your data files used by Outlook Express, first move the files to the new location. Your 
old files can be found at \Windows\Application Data\Microsoft\Outlook Express (which is the suggested 
default location when installing OE). If your files are not at this location, you can do a search (press F3) in 
Windows Explorer and search for *.mbx which will show you the location of the OE (mail) message box files.

We strongly suggest that you copy the files first, and once you are satisfied that OE is working correctly 
and that it is actually storing your files in the new location, you can delete the old files. 

Note: When Outlook Express is not installed on your system, this item will be greyed out.

Note: this item will be greyed out in the shareware version.



OE splash screen

Removing the check mark from this item will disable the Outlook Express splash screen.

Note: When Outlook Express is not installed on your system, this item will be greyed out.



Display Control Panel

Removing the check mark from this item will disable the Display Properties, both when right-clicking the Desktop 
and selecting Properties, and when selecting Control Panel - Display.

Note: This will not remove the Display icon in Control Panel, but when you try to access it, you will get a 
warning - as you also get when right-clicking the Desktop and choosing Properties from the context menu - 
that this function has been disabled by the systems administrator.



Background tab

Removing the check mark from this item will hide the Background tab in Display Properties, both when right-
clicking the Desktop and selecting Properties, and when selecting Control Panel - Display.

The Background tab is used to change the background (“Wall paper”) of the Desktop.



Screen Saver tab

Removing the check mark from this item will hide the Screen Saver tab in Display Properties, both when right-
clicking the Desktop and selecting Properties, and when selecting Control Panel - Display.

The Screen Saver tab is used to enable/change screen savers.

In Windows 95 you can also change the Energy saving features of the monitor on this tab.

In Windows 98 you can - besides the change in Energy saving features of the monitor - also change Power 
Management settings for the computer.



Appearance tab

Removing the check mark from this item will hide the Appearance tab in Display Properties, both when right-
clicking the Desktop and selecting Properties, and when selecting Control Panel - Display.

The Appearance tab is used to change colour schemes and other visual settings.



Settings tab

Removing the check mark from this item will hide the Settings tab in Display Properties, both when right-clicking 
the Desktop and selecting Properties, and when selecting Control Panel - Display.

The Settings tab is used:

In Windows 95 to:
Change the screen resolution and colour depth, change the (screen) font size, and to change the Graphics adapter 
driver and Monitor type.

In Windows 98 to:
In addition to the functions above, change the refresh rate of the Graphics adapter, change the hardware 
acceleration of the Graphics adapter*, change the colour profile used by your monitor.

*) The hardware acceleration of the Graphics adapter can also be changed from Control Panel - System - 
Performance.

When Microsoft Plus! is installed on Windows 95, disabling the Settings tab will also remove the Plus! tab when
you have a web browser prior to Internet Explorer 4.0

When Windows 98 is installed, disabling the Settings tab will also disable the Effects tab and Web tab.



Users Control Panel

Removing the check mark from this item will disable the Users applet from Control Panel, so users will not be 
able to add multiple users to the system.

The Users applet is only available on Windows 95 with Internet Explorer 4.x or higher installed on the system, 
and on Windows 98.

On Windows 95 without Internet Explorer 4.x or higher present on the system, disabling the Users Control Panel 
will removes the User Profiles tab from the Password Applet in Control Panel.

Note: This will not remove the Users icon in Control Panel, but when you try to access it, you will get a 
warning that this function has been disabled by the systems administrator.



Password Control Panel

(registered version only)

Removing the check mark from this item will disable the Password Properties from Control Panel, so users will 
not be able to add/change passwords or User Profiles.

Note: when IE 4.x or higher is installed on Windows 95, or when using Windows 98, you would also have to 
disable the Users Control Panel, because users can still add new users with new passwords to the system via 
the Users applet.

Note: This will not remove the Password icon in Control Panel, but when you try to access it, you will get a 
warning that this function has been disabled by the systems administrator.

Note: this item will be greyed out in the shareware version.



Change Passwords tab

(registered version only)

Removing the check mark from this item will hide the Change Passwords tab from Password Properties in 
Control Panel, thus users will not be able to change passwords.

Users can still add new users with new passwords. If you want to disable this functionality, you have to 
disable the Password Control Panel.

Note: this item will be greyed out in the shareware version.



 File System button

Removing the check mark from this item will hide the File System button on the Performance tab from the System
Properties (Control Panel - System).

This will prevent users from:

1. Change the Typical role of the computer
2. Change read ahead optimisation
3. Check or uncheck the Search for new floppy disk drives each time your computer starts
4. Change the supplemental cache for the CD-ROM drive
5. Enable or disable write-behind caching on all removable disk drives
6. Change Troubleshooting properties

Note that #3 and #5 only apply to Windows 98.



Virtual Memory button

Removing the check mark from this item will hide the Virtual Memory button on the Performance tab from the 
System Properties (Control Panel - System).

This prevent users from changing the Virtual memory settings.



MS-DOS Prompt

(registered version only)

Removing the check mark from the MS-DOS Prompt check box will prevent users from accessing the MS-DOS 
Prompt, as well as preventing the user to run MS-DOS based programs.

It also disables the Start - Shut Down - Restart in MS-DOS mode - you will get a warning that this function 
has been disabled by the systems administrator.

Note: this item will be greyed out in the shareware version.



Single-Mode MS-DOS

(registered version only)

Removing the check mark from the Single-Mode MS-DOS check box will remove the Restart in MS-DOS mode 
on the Shut Down menu. When you re-enable Single-Mode MS-DOS, you will have to restart Windows to recover 
the use of the Restart in MS-DOS mode on the Shut Down menu.

Note: this item will be greyed out in the shareware version.



Windows Update

Removing the check mark from the Windows Update check box, will disable the use of the Windows Update 
feature.

When PCs are centrally managed, it can be useful to switch the Windows Update feature off, so users will not be 
able to download any new drivers/patches using the Windows Update feature.

Note: This tab is only active on systems running Windows 98.



Task Monitor settings

(registered version only)

These items control the optimisation of applications when defragmenting your hard drive.

With the Use the application profile created by the Task Monitor checkbox, you can choose to enable/disable the 
use of the application profile. When checked, the application profile is used when defragmenting the hard drive. 
When profile is not used, programs are optimised in FindFirst/FindNext order of the Application.lgn files in the \
Windows\Applog folder, and the parameters below are ignored.

With the Minimum log file size you can control the size (in bytes) of log files to qualify for optimisation. 
Programs with log files smaller than this value are not optimised. These log files are stored in the (hidden) folder
\Windows\Applog. If you use the value 0, this parameter is ignored.

With the Profile lifespan of unused applications you can control the maximum amount of days a program will 
qualify for optimisation while not being used. If you use the value 0, this parameter is ignored.

With the Maximum number of profiled applications you can control the maximum amount of applications to 
be optimised. Programs are optimised in descending order of usage counts, up to this max. number. If you use the
value 0, this parameter is ignored.

Note: This tab is only active on systems running Windows 98.

Note: this item will be greyed out in the shareware version.



Windows version

Win95Ver is the easiest way of determining which version of Windows 95 you are running. Win95Ver distinguishes 
between the following versions of Windows 95 (listed from oldest to newest):

· Windows 95 original version
· Windows 95 OSR1 (Windows 95 original version plus Service Pack 1)
· Windows 95 OSR2
· Windows 95 OSR2.1 original (version 4.03.1212)
· Windows 95 OSR2.1 QFE (version 4.03.1214)
· Windows 95 OSR2.5 without USB support
· Windows 95 OSR2.5

The information displayed by Win95Ver can be saved to a text file by clicking the Save info button.

As an added bonus, Win95Ver also recognises Windows 98 and Windows NT.

Unrecognised versions of Windows 95

Quite a few people have accidentally installed Service Pack 1 on OSR2 (or higher) systems. I say "accidentally" 
because you should not install Service Pack 1 on OSR2 or higher!!!    Win95Ver will report these "versions" of 
Windows 95 as unrecognised. The most common case is that Service Pack 1 was installed on OSR2; in this case, 
the information displayed by Win95Ver will read as follows:



Information from the registry:
Version: Windows 95
Version number: 4.00.1111a

Information from Windows itself:
Version: 4.00
Build: 4.00.1111

We think (but have not actually tried it) that Service Pack 1 is smart enough to not replace newer versions of files
with older ones. If you happened to install Service Pack 1 on OSR2 or higher, then use the table below to check if
you still have the correct versions of the files that come with Service Pack 1. For each of these files, choose 
Properties, go to the Version tab, and look at the number displayed for File version. If a version number for a file 
currently on your computer is lower than listed here, you have to extract the correct version from the .CAB files 
on your Windows 95 CD. If a version number for a file currently on your computer is the same or higher than 
listed here, then leave that file alone. The table below assumes you have Windows 95 installed in the C:\
WINDOWS directory; adjust if necessary.

4.00.951 C:\WINDOWS\SYSTEM\COMDLG32.DLL
4.00.953 C:\WINDOWS\SYSTEM\LPT.VXD
4.00.952 C:\WINDOWS\SYSTEM\MSPWL32.DLL
4.00.951 C:\WINDOWS\SYSTEM\NWSERVER.VXD
2.1 C:\WINDOWS\SYSTEM\OLE32.DLL
4.40.311 C:\WINDOWS\SYSTEM\SAGE.DLL
4.00.1111 C:\WINDOWS\SYSTEM\SHELL32.DLL
4.00.1111 C:\WINDOWS\SYSTEM\VREDIR.VXD
4.00.1111 C:\WINDOWS\SYSTEM\VSERVER.VXD

Finally, to have the system identify itself correctly once again (so that Win95Ver will recognise it and so that the 
System Properties show the correct version), go to the following location in the registry (only do this if you 
accidentally installed Service Pack 1 on OSR2 or higher!!!):

HKEY_LOCAL_MACHINE \ SOFTWARE \ Microsoft \ Windows \ CurrentVersion

and set the string SubVersionNumber to the value “ B”. Note that there is a space before the B. Those who 
installed Service Pack 1 on OSR2.5 should set the string SubVersionNumber to the value “ C” instead.



Windows Tweaking Toolbox menu bar

The menu bar of Windows Tweaking Toolbox has 3 entries: 
File, Undo and Help. Here is a short description of their functions.

The File menu only has one entry Exit, and it does exactly what it’s supposed to do: It exits the program. Note that 
if you made any changes without pressing the Apply button, these changes are disregarded. 

The Apply/Undo menu has 3 entries, Apply all tabs, Undo current tab, and Undo all tabs. Here is how they 
work.

The Apply all tabs processes all changes made on all the tabs in the current session.

The Undo functions work from when the Windows Tweaking Toolbox was started. Any changes made during the 
current session can be undone from here - on a per tab basis, or on all tabs.

(the Apply/Undo functions are a feature of the registered version only)

The Help menu has two entries, Help and About. Help starts this help file, while About brings up the Windows 
Tweaking Toolbox About tab.



Uninstalling

The Windows Tweaking Toolbox Set-up creates an entry in the Add/Remove Programs section of Control 
Panel. To uninstall, simply select this entry and click the Add/Remove button.

You can also use the shortcut created in the Windows Tweaking Toolbox folder on the Start menu to uninstall the 
program.
 
Unlike a lot of uninstall programs out there, WTT really uninstalls itself. A lot of uninstall programs do not delete
themselves when the product is being uninstalled, which results in unused files usually located in the Windows 
directory. WTT also deletes its uninstall program.



Register

For more information and to Register, please visit:

http://www.graphic-locomotion.com/graphics/wtt.html

or

http://www.windows-help.net/wtt/
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